Complete race analysis on your laptop computer in the pits.

Download runs from your Auto Meter Data Logger with Data Facts Pro™
Introduction

Data-Facts Pro V3.0 Software

Data-Facts Pro V3.0 is the latest upgrade from the original Data-Facts Pro software package that has proven to be among the easiest Motorsports Data Acquisition programs to learn and understand! With additional features like expanded logbook searching, math channels and automatic run zeroing/synchronizing, Data-Facts Pro V3.0 will place you seconds ahead of your competition.

Advanced programming provides the ability to view multiple graphs for clear and concise comparison between runs. This includes an adjustable split screen with actual unit values (psi for pressure, degrees for temp, etc.), no conversion is necessary. Two axis zoom enables close up analysis of targeted areas down to one hundredth of a second on both the horizontal and vertical plane for a true microview.

Run Overlay helps you overlay multiple runs and now features a choice of automatic or manual sync and zero on the graph. A compare screen is available that calculates the performance difference of each channel every one hundredth of a second. Compare can be activated and moved to the most convenient screen location for pinpoint analysis right on the graph.

The Data-Facts Pro V3.0 Log Book has been expanded with double the search capability. You can find runs by searching up to 16 information fields including 8 user defined fields. Using specific criteria to locate run information enables you to see results, in seconds! The runs can then be opened from the log book page with only the click of your mouse. The Log Book also gives you the ability to add previous logs, eliminating hours of time spent searching through paper logs.

Data-Facts Pro V3.0 is compatible with Windows 95, 98, NT, 2000 and XP.
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation</td>
<td>4</td>
</tr>
<tr>
<td>Getting Started</td>
<td>4</td>
</tr>
<tr>
<td><strong>Main Screen</strong></td>
<td>5-8</td>
</tr>
<tr>
<td>Screen Appearance</td>
<td>5</td>
</tr>
<tr>
<td>File Menu</td>
<td>5-6</td>
</tr>
<tr>
<td>Graphs Menu</td>
<td>7</td>
</tr>
<tr>
<td>Log Book Menu</td>
<td>7</td>
</tr>
<tr>
<td>Options Menu</td>
<td>8</td>
</tr>
<tr>
<td>Window Menu</td>
<td>8</td>
</tr>
<tr>
<td>Help Menu</td>
<td>8</td>
</tr>
<tr>
<td><strong>Icons</strong></td>
<td>9</td>
</tr>
<tr>
<td><strong>Options Menu</strong></td>
<td>10-13</td>
</tr>
<tr>
<td>Set Sampling Rate</td>
<td>10</td>
</tr>
<tr>
<td>System Options</td>
<td>10-11</td>
</tr>
<tr>
<td>System Colors</td>
<td>12-13</td>
</tr>
<tr>
<td>System Fonts</td>
<td>13</td>
</tr>
<tr>
<td>Utilities</td>
<td>13</td>
</tr>
<tr>
<td><strong>File Menu</strong></td>
<td>14-24</td>
</tr>
<tr>
<td>Download Data File</td>
<td>14-15</td>
</tr>
<tr>
<td>Open Data File 1</td>
<td>16</td>
</tr>
<tr>
<td>Open Data File 2</td>
<td>17</td>
</tr>
<tr>
<td>Print Data</td>
<td>18</td>
</tr>
<tr>
<td>Maintenance</td>
<td>18-23</td>
</tr>
<tr>
<td>Category Maintenance</td>
<td>18-19</td>
</tr>
<tr>
<td>Question Maintenance</td>
<td>19-20</td>
</tr>
<tr>
<td>Question Order</td>
<td>20-21</td>
</tr>
<tr>
<td>Range Maintenance</td>
<td>21-22</td>
</tr>
<tr>
<td>Channel Maintenance</td>
<td>22-23</td>
</tr>
<tr>
<td>34 channel (Aux 5-20)</td>
<td>23</td>
</tr>
<tr>
<td>User Defined Field Maintenance</td>
<td>24</td>
</tr>
<tr>
<td>Exit</td>
<td>25</td>
</tr>
<tr>
<td><strong>Graphs Menu</strong></td>
<td>26-52</td>
</tr>
<tr>
<td>Graph Selected Channels</td>
<td>26-29</td>
</tr>
<tr>
<td>RPM Quick Graph - 1</td>
<td>29</td>
</tr>
<tr>
<td>Cylinder Temp (EGT) Quick Graph</td>
<td>30</td>
</tr>
<tr>
<td>1</td>
<td>30</td>
</tr>
<tr>
<td>RPM Quick Graph - 2</td>
<td>31</td>
</tr>
<tr>
<td>Cylinder Temp (EGT) Quick Graph</td>
<td>32</td>
</tr>
<tr>
<td>2</td>
<td>32</td>
</tr>
<tr>
<td><strong>Helpful Tips</strong></td>
<td>51-53</td>
</tr>
<tr>
<td>Shortcut Keys</td>
<td>51</td>
</tr>
<tr>
<td>Vertical Bar</td>
<td>52</td>
</tr>
<tr>
<td>Adding Channels on the Fly</td>
<td>52</td>
</tr>
<tr>
<td>Right Mouse Button Options</td>
<td>53</td>
</tr>
<tr>
<td><strong>Log Book Menu</strong></td>
<td>54</td>
</tr>
<tr>
<td>Search Log Info</td>
<td>54-55</td>
</tr>
<tr>
<td>Log Book</td>
<td>55-56</td>
</tr>
<tr>
<td>Add Previous Logs</td>
<td>56</td>
</tr>
<tr>
<td><strong>Window Menu</strong></td>
<td>57</td>
</tr>
<tr>
<td>Help</td>
<td>57</td>
</tr>
<tr>
<td><strong>Helpful Tips Card</strong></td>
<td>58</td>
</tr>
<tr>
<td><strong>Keyboard Template</strong></td>
<td>59</td>
</tr>
<tr>
<td>Notes</td>
<td>60</td>
</tr>
</tbody>
</table>
Installation

Windows 95, 98, NT, 2000, and XP

Complete the steps below to install Data-Facts Pro V3.0 on your computer for Windows 95, 98, NT, 2000 and XP applications.

1. Insert the CD into the CD Rom.
   RESULT: One of the following results will occur:
   • If the set-up does not start automatically, proceed to step 2.
   • If the set-up starts automatically, proceed to step 5.

2. Double click on the My Computer icon located on the Windows desktop.
3. Double click on the designated CD Rom drive.
4. Double click on the Set-up icon. (setup.exe)
5. The welcome window will ask you if you want to install the program, click OK.
6. The Select Destination Directory window will ask for the directory to install the program in, click OK to accept the default directory which is C:\Program Files\Datafact.
   (It is recommended that the default directory is used.)
   RESULT: The files from the CD are loaded onto the selected drive.
7. Remove the CD from the CD Rom.
8. After the installation is complete, close the CD Rom drive window.

Trademarks

All terms mentioned in this instruction that are known to be trademarks or service marks are listed below. In addition, terms suspected of being trademarks or service marks have been appropriately capitalized. Auto Meter Products, Inc. cannot attest to the accuracy of this information. Use of a term in this instruction should not be regarded as affecting the validity of any trademark or service mark.

Terms:
Windows 95, 98, NT, 2000 and XP are trademarks of Microsoft Corporation.
Data-Facts Pro is a trademark of Auto Meter Products, Inc.

Getting Started

Windows 95, 98, NT, 2000 and XP

Complete either set of steps below to run Data-Facts Pro V3.0 on your computer for Windows 95, 98, NT, 2000 and XP applications.

1. Click START, PROGRAMS, Datafact, Datafacts 3.0

   or

1. If the My Computer window is not still open, double click on the My Computer icon.
2. Double click on the disk C: icon located in the My Computer window.
3. Double click on the folder labeled Program Files.
4. Double click on the Data-Facts folder located in the Program Files folder.
5. Double click on the Data-Facts icon in the Datafacts folder.
6. If you want to create a shortcut on your desktop, Right click and hold on the Data facts icon in the Data facts folder, then drag over the desktop. When the mouse button is released, Select the “create shortcut here” option.

RESULT: The Data-Facts Pro software is now running on your computer.
Main Screen

Screen Appearance
This is the main screen that will display after opening the Data-Facts Pro software.

**NOTE:** No runs are listed in the windows at the bottom of the screen and no graphs are displayed.

---

Menus
The main screen provides you with 6 different menus:
- File
- Graphs
- Log Book
- Options
- Window
- Help

---

File Menu
Below is a list of options provided within the file menu including a brief description:

**Open Data File 1** - Opens a file which was previously downloaded from the Data Logger.

**Open Data File 2** - Opens a second file which was previously downloaded from the Data Logger.
**NOTE:** You must have a file open in File 1 to use File 2.

**Download Data File** - Downloads a run from the Data Logger and creates a file named by you.

**Print Data** - Prints text data from opened data file only.
**NOTE:** If 2 files are open, only data file 1 will print.
Main Screen

File Menu, cont'd

Maintenance - Offers a sub-menu with the following maintenance options:

- **Category Maintenance** - Enables you to add, change or delete categories in your log book. (See page 18)

- **Question Maintenance** - Enables you to add, change or delete the questions asked in the log book. (See page 19)

- **Question Order** - Enables you to prioritize the order questions are asked in the log book. (See page 20)

- **Range Maintenance** - Enables you to update the ranges displayed in your graphs. (See page 21)

- **Channel Maintenance** - Enables you to add, change or delete channel information. (See page 22)

- **User Defined Field Maintenance** - Enables you to name or rename 8 User Defined fields in the Search Log Info feature. (See page 24)

**Exit** - Returns you to Windows.
Graphs Menu

Below is a list of options provided within the Graphs menu including a brief description:

<table>
<thead>
<tr>
<th>Graph</th>
<th>Keyboard Shortcuts</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph Selected Channels</td>
<td>F2</td>
<td>Enables you to graph selected channels manually.</td>
</tr>
<tr>
<td>RPM Quick Graph 1</td>
<td>F3</td>
<td>Automatically creates a graph displaying Engine, Input Shaft and Drive Shaft RPM channels for Run 1. (See page 29)</td>
</tr>
<tr>
<td>Cylinder Temp Quick Graph 1</td>
<td>F4</td>
<td>Automatically creates a graph displaying cylinder temperature channels for Run 1. (See page 30)</td>
</tr>
<tr>
<td>RPM Quick Graph 2</td>
<td>F5</td>
<td>Automatically creates a graph displaying Engine, Input Shaft and Drive Shaft RPM channels for Run 2. (See page 31)</td>
</tr>
<tr>
<td>Cylinder Temp Quick Graph 2</td>
<td>F6</td>
<td>Automatically creates a graph displaying cylinder temperature channels for Run 2. (See page 32)</td>
</tr>
</tbody>
</table>

NOTE: The function keys (F2 - F6) cannot be used with graph menu open.

Log Book Menu

Below is a list of options provided within the log book menu including a brief description:

<table>
<thead>
<tr>
<th>Log Book</th>
<th>Keyboard Shortcuts</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Log Info</td>
<td>Ctrl+I</td>
<td>Enables you to search and view logged information from previous runs.       (See page 54)</td>
</tr>
<tr>
<td>Log Book</td>
<td>Ctrl+L</td>
<td>Accesses the log book for the open run.                                    (See page 55)</td>
</tr>
<tr>
<td>Add Previous Logs</td>
<td>Ctrl+P</td>
<td>Enables you to add run information from your previous log books and utilize the Search Log Info feature. (If the run is not downloaded from the Data Logger, the graph feature will not be available). (See page 56)</td>
</tr>
</tbody>
</table>

NOTE: A run must be opened first before using this feature.
Options Menu
Below is a list of options provided within the options menu including a brief description:

Set Sampling Rate - Not implemented in this version.

System Options - Enables you to customize Data-Facts Pro V3.0 to your specific wants or needs. (See page 10)

System Colors - Enables you to change the colors used in the graphs including the foreground and background. (See page 12)

System Font - Not implemented in this version.

Utilities - Offers a sub-menu with the following Utilities option:
Filter File Manually - enables a file to be cleaned of data preventing the file to be opened and graphed, resulting in a prompt window stating "invalid data file". (See page 13)

Window Menu
Below is a list of options provided to show opened log book pages within the Window menu including a brief description:

Cascade - Used to arrange multiple log book pages.
Tile Horizontally - Used to arrange multiple log book pages.
Tile Vertically - Used to arrange multiple log book pages.
Arrange Icons - Not implemented in this version of software.
Close All Windows - Closes all of the open windows in the log book feature.

Help Menu
Below is a list of options provided within the help menu including a brief description:

About Data Facts - Shows your name and software version for 5 seconds.
Search For - Not implemented in this version.
Contents - Not implemented in this version.
Icons

Below is a list of Icons provided on the main screen in order for you to execute a specific function more quickly.

- **Open Data File 1** - Refer to page 16 for more detail.
- **Open Data File 2** - Refer to pages 17.
- **Download Data File** - Refer to pages 14 and 15.
- **Print Text Data File** - Refer to page 18.
- **Graph Selected Channels** - Refer to pages 26-29.
- **RPM Quick Graph** - Refer to page 29.
- **EGT Quick Graph** - Refer to page 30.
- **Log Book** - Refer to pages 55 and 56.
- **Search Log Books** - Refer to pages 54 and 55.
- **About Data Facts** - Displays your name, address, city, state, zip and the software version number for 5 seconds.
- **Switch Overlap Mode** - Refer to page 11. (Overlap Axis)
- **Switch Autoscale Mode** - Refer to page 11. (Automatic Scaling)
Options Menu

Use this function to set-up system configuration.

Set Sampling Rate
This function is not implemented in this version of software.

System Options
This function allows you to customize Data-Facts Pro to your specific needs for downloading and graphing.

1. Click on the Options menu.
2. Click on System Options.

RESULT: The System Options dialog box will open.
The functions listed below are provided within the System Options sub-menu.

**Comm Port** - Assigns the serial port on the computer that is used for downloading files. The system defaults to Comm Port 1.

**Baud Rate** - Select the baud rate that matches the download device you are using:
- Download Box; 19200, Auto Meter Part #9391.
- Standard Download Cable Kit; 19200, Auto Meter Part #9399.
- Upgraded Download Cable Kit; 56000, Auto Meter Part #9396.
The system defaults to 56000.

**Plot Type** - Enables you to change the points and lines used for the graph. The system defaults to Line.

**Graph Annotations** - Enables you to mark annotations on your graph if the timeslip information is entered in the Log Book. It is recommended that 60 ET, 330 ET, 660 ET, 1000 ET and 1320 ET are checked √.

**Page Up/Page Down** - Enables you to change the direction of the vertical bar on the graph when using the Page Up or Page Down, or up and down arrow keys. When using the page up or page down keys, the vertical bar moves .2 second. The system defaults to Left / Right.

**Plot Style** - Enables you to change the thickness of the graphed lines to small, medium or large. The system defaults to medium.

**First Reading** - Not implemented in this version.

**Print Style** - Depending of the printer you have connected to your computer you can select either a color printer (this will print the same colors you see on your display) or monochrome with symbols (dot matrix, laser, or a non color printer).

**Print Samples Per Second** - Enables you to print the actual data from the stored run in 10, 25, 50 or 100 samples per second to your printer.

**Profile Order** - Enables you to change the order of your shortcuts. Refer to page 28.

**Zoom Mode** - Enables you to select Horizontal or Horizontal/Vertical. The Horizontal/ Vertical mode is recommended.

**Use Error Correction** - This feature will help filter out some noise on the different channels when this feature is checked √.

**Auto Load Runs** - Automatically opens the data file when downloading. It is recommended that this feature is checked √.

**Auto Reset 0** - Automatically resets the first drive shaft movement on the graph to 0 seconds. It is recommended that this feature is checked √.

**Auto Sync** - Automatically aligns the graph based on the first drive shaft reading when comparing 2 graphs. It is recommended that this feature is checked √.

**Automatic Run Numbers** - Not implemented in this version.

**Compare Always On Top** - This feature is utilized when comparing 2 graphs. The compare window always remains on top of the graph window, enabling you to move the compare window to suit your needs. It is recommended that this feature is checked √.

**Overlap Axis** - Enables you to use single screen or split screen options.

**Automatic Scaling** - Sets axis depending on data shown. Computer will determine scaling of graph.
System Colors
This function enables you to change any color in the graph including the foreground and background.

1. Click Options.
2. Click System Colors.

RESULT: The System Colors dialog box appears.

Note: Select "Factory Defaults" to return to default colors. If selected, all color settings will be replaced with factory settings.
3. Click Set next to the specific channel or background color you want to change.

RESULT: The Color Selection dialog box appears and the current color assigned is displayed.

4. If a color change is desired, select a color from the palate and click select. If not, click exit.
5. Upon returning to the System Colors dialog box, click one of the following options:
   • OK - Saves changes to the system colors.
   • Exit - Returns to the main screen without saving changes to the system colors.

System Fonts
This function is not implemented in this version.

Utilities

Filter File Manually enables a file to be cleaned of data preventing the file to be opened and graphed, resulting in a prompt window stating "invalid data file". It is recommended that the file be backed up on disk prior to filtering.

1. Click Options.
2. Click Utilities.
3. Click Filter File Manually.
4. Double Click the chosen file.
5. Open file. (See How to Open a Data File, Page 16)
Download Data File

Follow the steps below to download a run from the Data Logger at anytime.

1. Click on one of the following:
   - The File menu, then proceed to Step 2.
   - Click on the Download Data File icon and proceed to Step 3.

2. Click on Download Data File.

RESULT: The Save As dialog box appears:
3. Enter the File Name for the run in the text field.
   - You may store your data in any directory on any drive, however the system defaults to C:\Data\fact\data.
   - The .rtd extension is the only extension Data Facts Pro will recognize.
   - You do not have to add this extension to your file names, it is added automatically.
   - You must conform to standard Windows naming conventions when naming your files.
     Name length is limited to 7 characters plus .rtd.

   **Suggestions for naming files:**
   - 0808991.rtd - This run occurred on 08/08/99 and was the 1st run on the track.
   - GVQ198.rtd - This run was a Gainesville qualifying 1st run in 1998.

4. Click Save to start the download.
   **RESULT:**
   - The Press Button To Cancel Download dialog box appears.
     If you want to cancel the download, click **cancel**.

   ![Press Button To Cancel Download](image)

   - The bottom left corner of the screen will display download.
   - Next, start the download at the Data logger.
     See Download Cable Kit Instructions in the operating manual.
   - As data transfers into the file a rising sequence of occur at the rate of 7600 per 1 second of data.
   - The system automatically returns you to the main screen once the download is complete.
     If the Auto Load Run option is selected (which can be found in system options. See pages 10 - 11, the run is automatically opened and the file name displays in the bottom left corner of the screen.

   **NOTE:** Follow the steps on pages 26-52 to graph data files.
File

Open Data File 1
Follow the steps below to open a data file.

1. Click on one of the following:
   • The File menu, then proceed to Step 2.
   • Click on the Open Data File 1 icon and proceed to Step 3.

2. Click on Open Data File 1.

RESULT: The Select Data File To Load dialog box appears.

3. Select a file name from the list provided by highlighting the name then clicking OK or double clicking on the file name.

RESULT: • The Reading Data Records dialog box appears.

• When the system is finished reading the data, the dialog box will disappear. The file name will appear in the bottom left corner of your screen.

NOTE: Follow the steps on pages 26-52 to graph data files.
Files

Open Data File 2

Follow the steps below to open a second downloaded data file.

1. Click on one of the following:
   • The File menu, then proceed to Step 2.
   • Click on the Open Data File 2 icon and proceed to Step 3.

2. Click on Open Data File 2.

RESULT: The Select Data File To Load dialog box appears:

3. Select a file name from the list provided by highlighting the name then clicking OK or double clicking on the file name.

RESULT: The Reading Data Records dialog box appears.

- When the system is finished reading the data, the dialog box will disappear. The file name will appear in the bottom left corner of your screen, next to the first file name.

NOTE: Follow the steps on pages 26-52 to graph data files.
Print Data
Follow the steps below to print the text data from an opened data file:

1. Click on one of the following:
   - The File menu, then proceed to Step 2.
   - Click on the Print icon.

2. Click on Print Data.

Maintenance
There are several maintenance options provided within the Maintenance sub-menu.

Category Maintenance
Follow the steps below to add, change or delete the categories available in your log book:

1. Click on the File menu.
2. Move the pointer to Maintenance.
3. Click on Category Maintenance.

RESULT: The Category Maintenance dialog box appears.
4. Click on **Prev** or **Next** to view previously entered categories.
5. Click on **Update** to change a previously entered category.
6. Click on **Add** to save the category.
7. In the Category field, type the name of the category you want to add, change or delete.
8. In the Description field, type a brief description of the category (optional).
9. Click on **Clear** to erase typed information.
10. Click on **Delete** to eliminate a category from the log book.
11. After you are done performing category maintenance, click on **Exit**.

**Question Maintenance**

Follow the Steps below to add, change or delete the questions asked in the log book; for each category.

1. Click on the **File** menu.
2. Move the pointer to **Maintenance**.
3. Click on **Question Maintenance**.

RESULT: The Question Maintenance dialog box appears.

4. In the Category field, select one of the following:
   - Click on the **pull down arrow** then select the category you want to edit, or type the name of the category you want to add, change or delete.
   - Typing the first letter of the category will take you to a list that matches that character. Typing it again will take you to the next matching category, providing that there is more than one match for that character or type a different letter and start over again.
   You can also view the category list by clicking **Next** or **Prev**.
Question Maintenance, cont’d

5. In the Question field, type the question you want to add, change or delete. (When typing in the question you wish to add, keep in mind that only the first portion can be viewed).

6. If you want to change the order that the question is asked in the log book, refer to Question Order on pages 20 and 21.

7. Click on Add to add the question to the log book.

8. Click on Prev or Next to view previously entered questions.
   - If no questions have been added to a category, use the pull down arrow to find that category.

9. Click on Update to change the question or the order it is asked.

10. Click on Clear to erase typed information.

11. Click on Delete to remove the question from the log book.

12. After you are done performing question maintenance, click on Exit.

Note: This is important! Taking some time for a little preparation on question size is recommended. There is only a limited amount of space while viewing the Log Book, so abbreviating is very important.

Question Order

Follow the steps below to alter the order of the questions asked in the log book:

1. Click on the File menu.

2. Click on Maintenance.

3. Click on Question Order.

RESULT: The Set Question Order dialog box appears.
4. Using the up or down arrows, scroll through the list of questions until you find the questions you want to change, and click once on that question.
5. Click on the Down or Up icon until the order of the question has changed to what you want.
6. Click OK and then click Exit to accept the changes or Exit to return to the main screen without saving the changes.

**Range Maintenance**

Follow the steps below to change the ranges of the information displayed on your graphs which enables you to customize the size of the graph that displays on your screen:

1. Click on the **File** menu.
2. Click on **Maintenance**.
3. Click on **Range Maintenance**.

RESULT: The Password dialog box appears.

4. No password is required. Click OK to logon as a user.
RESULT: One of four of the following Range Maintenance dialog boxes appears.
File Menu
Range Maintenance, cont’d

5. In the Min Range field, type the minimum range.
6. In the Max Range field, type the maximum range.
7. Click on Prev or Next to view previously entered ranges.
8. Update must be clicked to change a previously entered range.
9. After Update has been chosen, click on Exit to return to the main screen.

NOTE: The add, clear and delete functions are not implemented.

Channel Maintenance
Follow the steps below to add, change or delete channel information:

1. Click on the File menu.
2. Click on Maintenance.
3. Click on Channel Maintenance.

RESULT: The Password dialog box appears.

4. No password is required. Click OK to logon as a user.
RESULT: The Channel Maintenance dialog box appears.
5. Click on **Prev** or **Next** to view the different channels.
6. Range Name: by using the pull down arrow you can change where the channel is graphed on the screen. This enables you to customize the split screen.
7. Alias: enables you to change the name of the selected channel.
8. Decimal Places
9. Modifier: This is the channel math function. The signal can be modified for each channel.
10. Value: This is the value you want to modify with.
11. Units: Use the pulldown arrow to change the units.
12. Virtual and Vs Virtual are not implemented in this version.
13. First reading is not implemented in this version.
14. Acceleration is not implemented in this version.
15. Error Correction: Enables you to customize your graph scale for each channel. When manual scaling is used.
16. Click on **Update** to save any changes.
17. Click on **Exit** to return to the main screen.

**NOTE:** The add, clear, calibration and delete functions are not implemented in this version. The calibration function is for Aux 5-20 for 34 Channel.

**34 Channel (Aux 5-20)**
To calibrate any auxiliary channel 5-20 you will need the small channel calibration card that came with the sensor. Make sure you have that card before proceeding with the remaining steps.

1. Using the PREV & NEXT buttons, scroll through the list of channels until you find the channel you would like to calibrate.
2. Once you have found the correct channel,
3. Select the CALIBRATION button
4. The Calibration Settings window will open.
5. Enter the calibrations as they appear on the calibration sheet that came with the sensor.
6. In the upper left box, enter the first unit number
7. In the box next to that, enter the ADC number for that reading
8. Repeat for each reading on the calibration sheet
   They should appear similar to this:

![Calibration Settings](image)

9. When finished, select SAVE
10. Then select UPDATE
11. Make sure to click UPDATE before exiting the channel calibration window otherwise your changes will not take effect.
12. When you are finished calibrating and updating the software, click EXIT

The channel calibrations are now entered into the software.
Each time you download a run from a 34 channel data logger, the channel calibration settings you have entered on your computer will be applied to the corresponding channels in the data file. Once a file has been downloaded, the raw data can not be re-calibrated. If you find an error in the channel calibration data in the software, correct the calibration settings and download the run from the data logger again.
File Menu
User Defined Field Maintenance
This is an excellent feature which enables you to narrow your searches for log book information. Follow the steps below to name or rename the 8 user defined fields, used in the Search Log Info feature:

1. Click on the File menu.
2. Move the pointer to Maintenance.
3. Click on User Defined Field Maintenance.

RESULT: The User Defined field Maintenance dialog box appears.

4. Select the User Defined field you want to name or rename by checking the box.
5. In the text field, type a title for the User Defined Field.
   NOTE: Fields 1 through 4 require a numeric title such as reaction time, air temperature, car number, etc. Fields 5 through 8 require an alpha title such as car name, lane, etc. The title names should be 8 characters or less.
6. Click on Save to save the changes or Exit to return to the main screen without saving the changes.
Exit
Follow the steps below to close Data-Facts Pro and return to Windows.

1. Click on the **File** menu.
2. Click on **Exit**.

RESULT: The Exit dialog box appears.

3. Click **Yes** to exit or **No** to return to the main screen.
Graph Menu

Once a file is opened (See page 16 or 17), a graph can be created from the data. You may choose to manually or automatically load graphs onto the screen.

Graph Selected Channels
This function enables you to manually choose specific channels you want to graph. Follow the steps below to graph selected channels.

1. Click on one of the following:
   - The Graphs menu, then proceed to Step 2.
   - Press F2, then proceed to Step 3.
   - The Graph Records icon and proceed to Step 3.

2. Click on Graph Selected Channels.

RESULT: The Select Channels To Graph dialog box appears.
If only one run or file is opened, the dialog box below appears:
If two runs or files are opened, the dialog box below appears:

3. Click on **1 - Engine RPM**.
4. Click the **Add >>** button or double click on **1 - Engine RPM**.

**RESULT:** The **1 - Engine RPM** channel will move from the Available Channels column to the Channels to Graph column.

5. Add additional channels you wish to activate for the graph.
6. If 2 runs are opened, click on **2 - Engine RPM**.
7. Click the second **Add >>** button or double click on **2 - Engine RPM**.

**RESULT:** The **2 - Engine RPM** channel will move from the Available Channels column to the Channels to Graph column.
8. Add additional channels you wish to activate for the second run.
9. After the channels are selected, click on one of the following:
   - Graph icon - displays graph
   - Add icon - creates a shortcut for the selected channels.

RESULT: The Add New Profile dialog box appears.

1. Type in the Profile Name for your channel selections.
2. Click on Add to save the profile or Exit to return to the main screen without saving the profile. (You can only save up to 20 profiles.)

RESULT: If added, the channel is displayed on the Main Screen and in the Graphs Menu.

- Delete icon - Deletes the selection.
- Graph icon - enables you to view the graph.

RESULT: The following window will appear displaying the customized graph that was selected:

- Exit icon - returns you to the main screen.
To delete a profile:

Click Graph Selected Channels, or hit F2. In the Graph Selected Channels window there are two icons in the lower left corner. Click the Delete icon and a window will open that shows the names of the profiles that have been created. You can then select the profile you wish to delete and select Delete. This will remove the profile from the toolbar.

**RPM Quick Graph - 1**

This function automatically graphs the following channels for run 1:

- 1 - Engine RPM
- 1 - Input Shaft
- 1 - Drive RPM

Follow the steps below to create a RPM Quick Graph for run 1.

1. Press F3 or click on one of the following:
   - The RPM Quick Graph icon.
   - The Graphs menu, then proceed to step 2.

2. Click on RPM Quick Graph - 1.

RESULT: The Select Channels to Graph dialog box appears momentarily, then the graph appears.
Cylinder Temp (EGT) Quick Graph - 1

This function automatically graphs cylinder temperature channels for Run 1. Follow the steps below to create a Cylinder Temp Quick Graph for Run 1.

1. Select one of the following:
   - Click on the Graphs menu, then proceed to step 2.
   - Press F4.
   - Click on the EGT Quick Graph icon.

2. Click on Cylinder Temp Quick Graph - 1.

RESULT: The Select Channels to Graph dialog box appears momentarily, then the graph appears.
RPM Quick Graph - 2

(Note: A file must be open in Run 2.)

This function automatically graphs the following channels for Run 2:
- 2 - Engine RPM
- 2 - Input Shaft
- 2 - Drive RPM

Follow the steps below to create a RPM Quick Graph for run 2.

1. Select one of the following:
   - Click on the Graphs menu, then proceed to step 2.
   - Press F5.
2. Click on RPM Quick Graph - 2.

RESULT: The Select Channels to Graph dialog box appears momentarily, then the graph appears.
Graph Menu

Cylinder Temp (EGT) Quick Graph - 2

This function automatically graphs cylinder temperature channels for Run 2. Follow the steps below to create a Cylinder Temp Quick Graph for Run 2.

1. Select one of the following:
   • Click on the **Graphs** menu, then proceed to step 2.
   • Press F6.

2. Click on **Cylinder Temp Quick Graph - 2**.

RESULT: The Select Channels to Graph dialog box appears momentarily, then the graph appears.
Graph Options
After a graph is created, the following menu options are available:

- Graph - See page 26-45.
- Run 1 (Run 2) - See page 45.
- Sync - See page 46.
- Hide - See page 46.
- Reset 0 - See page 47.
- Crop - See page 47.
- Compare - See page 48.
- Correct - See page 48-49.
- Zoom Out - See page 49-50.
- Quick - See page 50.
- Log - See page 51.
- Window - See page 51.
Graph Menu

Maximize Graph

Follow the steps below to maximize a graph:

1. Select one of the following:
   - Click on the Graph menu, then proceed to step 2.
   - Press the ‘M’ key, then proceed to step 3.

2. Click on Maximize Graph.

RESULT: An enlarged view of the graph appears:

3. Click on the title bar or press the ESC key to return the graph to its original size.
Customize Graph

This feature allows you to customize the look of your graph. Customization dialog can also be accessed by clicking the right mouse button while in the graph, refer to page 53.

Follow the steps below to begin customizing your graph:
1. Select one of the following:
   - Click on the Graph menu, then proceed to step 2.
   - Press the ‘C’ key, then proceed to step 3.

2. Click on Customize Graph.

3. Use the following command keys to customize your graph:
   - OK - Saves your customization selections.
   - Cancel - Exits customization without saving changes.
   - Apply - Applies the selection, then enables you to save or cancel the selection. (Use the Apply command when making multiple changes).
   - Help - Not implemented in this version.
   - Original - Discards the changes and displays the last saved version of the graph.
   - Export - Enables you to save the graph outside of the Data-Facts Pro software.
   - Maximize - Enlarges the graph to full screen and removes the dialog box.
Graph Menu
Customize Graph, cont'd

General
The following selections are available within the General tab:

**Main Title** - Enables you to set up a general title.

**Sub Title** - Enables you to set up a more precise title.

**Viewing Style** -
- Color - Full color option.
- Monochrome - One color option (gray scale).
- Monochrome + Symbols - One color option with symbols for lines of data.

*Hint: Viewing Style can also be accessed by clicking the right mouse button while in the graph (see Helpful Tips at the end of the graph section).*

**Font Size** - Enables you to change the font size to small, medium or large.

*Hint: Font Size can also be accessed by clicking the right mouse button while in the graph (see Helpful Tips at the end of the graph section).*

**Show Annotations** - Enables you to mark annotations on your graph if this feature is checked √.

**Numeric Precision** - Enables you to determine how precise the measurements are on the graph.
- 0 - View data in whole numbers only (ex. 10).
- 1 - View a tenth of a measurement (ex. 10.5).
- 2 - View a hundredth of a measurement (ex. 10.49).
- 3 - View a thousandth of a measurement (10.492).

*Hint: Numerical Precision can also be accessed by clicking the right mouse button while in the graph (see Helpful Tips at the end of the graph section).*
Grid Lines -  
- Both - Shows horizontal and vertical grid lines.  
- Y - Shows horizontal grid lines only.  
- X - Shows vertical grid lines only.  
- None - No grid lines are shown.  

Hint: Grid Lines can also be accessed by clicking the right mouse button while in the graph (see Helpful Tips at the end of the graph section).

Grid in front of data - Moves the grid lines in front of the data if this feature is checked ✓.

Plot Style

Enables you to use different types of points and lines for the graph. The following selections are available within the Plot Style tab:

Axis - Enables you to change the graphs Y and X axis.

3D Shadow Effect - Not implemented in this version.

Mark Data Points - Shows you the exact points on the graph where the computer sampled data.  

Hint: Mark Data Points can also be accessed by clicking the right mouse button while in the graph (see Helpful Tips at the end of the graph section).
Graph Menu

Customize Graph, cont'd

Plot Style -
- Line
- Points
- Points+BestFitCurve
- Points+BestFitLine
- Points+Line
- Points+Spline
- Spline

Hint: Plot Style can also be accessed by clicking the right mouse button while in the graph (see Helpful Tips at the end of the graph section).

Comparison Plot Style - Not implemented in this version of software.

Subsets
Not implemented in this version of software.

Font
Select fonts to be displayed for the titles.

![Customization... Window](image)
Color
Selects the colors to be used in the graph.

Style
Enables you to change the color and style of the graph lines.
Graph Menu

Graph Size
This feature enables you to change the graph size if both axes are displayed on the graph. Follow the steps below to change the size of your graph:
1. Click on the Graph menu.
2. Click on Graph Size.

RESULT: The Set Graph Size dialog box appears.

3. Use the up or down arrow to change the upper axis or lower axis.
4. Click OK to save the changes or Exit to return to the graph without saving changes.
Set Axis

(Note: Autoscale must be disabled. See page 10-11.)

This feature enables you to change the range of the displayed
channels. Follow the steps below to set the axis:
1. Click on the Graph menu.
2. Click on Set Axis.

RESULT: The information displayed on the graph will appear in the Set Temporary Axis dialog box appears.

3. Type the starting and ending values.
4. If the Make Changes Permanent box is checked √, the changes will become the new default.
5. Click OK to save the changes or Exit to return to the graph with out saving the changes.
Graph Menu

Show Graph Annotations
(Must be enabled in Option/System Options P. 10-11)
If the timeslip information is entered into the Log Book, this feature enables you to view the marked annotations on the graph. Follow the steps below to show or remove graph annotations: (A check mark will appear if Show Graph Annotations is turned on.)

1. Select one of the following:
   • Click on the Graph menu, then proceed to step 2.
   • Press and hold both the Control key and the 'A' key.
2. Click on Show Graph Annotations.

RESULT: The annotations are displayed on the graph.

NOTE: To enable this feature automatically, refer to System Options, Graph Annotations on page 10-11.
Add New Profile
Follow the steps below to create a shortcut for selected channels.
1. Click on the Graph menu.
2. Move pointer to Add New Profile.
Results: See page 28.

Grid Lines
Follow the steps below to change the grid lines displayed in the graph:

1. Click on the Graph menu.
2. Move the pointer to Grid Lines.
3. Click on one of the following, depending on what you want:
   • No Grid Lines
   • Horizontal Grid Lines
   • Vertical Grid Lines
   • Both Grid Lines
Graph Menu

Export Picture
This feature enables you to export the graph into a different application. The export feature is designed for the **advanced Windows user**.

Follow the steps below to export the graph:
1. Click on the **Graph** menu.
2. Click on **Export Picture**.

RESULT: The Exporting dialog box appears.

3. Select the file format you want to save the graph as:
   - MetaFile
   - BitMap
   - Text/Data Only
4. Select the Export Destination:
   - Clipboard - Moves the graph to your desktop.
   - File - Saves the graph as a file for later use.
   - Printer - Opens the Windows Print dialog box.
   Click OK to print or Cancel to exit without printing.

5. Select the Object Size:
   - No Specific Size
   - Millimeters
   - Inches
   - Points

6. Click on Export to export the graph or Cancel to return to the graph.

Print
Follow the steps below to print the graph:
1. Click on the Graph menu.
2. Click on Print.

Exit
Follow the steps below to return to the Main Screen:
1. Click on the Graph menu.
2. Click on Exit.

RESULT: The Main Screen appears.

Run 1 (Run 2) Menu
This feature enables you to toggle between information for Run 1 and Run 2. Two runs must be opened to utilize this feature. Follow the step below to toggle between runs.

1. Click on one of the following:
   - Run 1 - To view information from Run 1.
   - Run 2 - To view information from Run 2
Graph Menu

Sync Menu
This feature enables you to synchronize two runs automatically or manually. When two runs are synchronized, they start at the exact same position, making it easier for you to compare the runs. Refer to page 10-11 to set Auto Sync as the system default.

Follow the steps below to synchronize two runs, based on the first drive shaft movement:

**Auto Sync**
1. Click on the Sync menu.
2. Click on Auto Sync.

RESULT: The runs are synchronized based on the first drive shaft movement.

**Manual Sync**
1. Move the vertical bar to the start of Run 1.
2. Click on the Sync menu.
4. Click on Set Start of Run 1.

RESULT: The Datafact dialog box appears.

3. Click OK
4. Move the vertical bar to the start of Run 2.
5. Click on the Sync menu.
7. Click on Set Start of Run 2.

RESULT: The Datafact dialog box appears.

8. Click on the Sync menu.
7. Click on Synchronize.

Hide (Show) Menu
Follow the steps below to hide run information and expand the graph or show run information and decrease the size of the graph:
1. Click on the Hide menu to hide the run information.
2. Click on the Show menu to view the run information.
Reset 0 Menu
This feature enables you to reset the time index, matching it to the first drive shaft movement or any position on the graph. Refer to page 10-11 to set Auto Reset 0 as the system default. Follow the steps below to reset the time index automatically or manually:

**Automatic Reset**
1. Click on the Reset 0 menu.
2. Click on Automatic Reset.

**Manual Reset**
1. Move the vertical bar to the desired 0 position.
2. Click on the Reset 0 menu.
3. Click on Manual Reset.

Crop Menu
This feature enables you to remove the left or right portion of the graph temporarily or permanently. You can crop the graph as many times as you want, however, you cannot make changes permanent if 2 runs are loaded. Once you make the changes permanent, there are no procedures available to restore the cropped data.

Follow the steps below to crop information:

**Crop Left**
1. Set the vertical bar to the desired position.
2. Click on the Crop menu.
3. Click on Crop Left.

**Crop Right**
1. Set the vertical bar to the desired position.
2. Click on the Crop menu.
3. Click on Crop Right.

**NOTE:** Synchronized graphs will become unsynchronized when the graph is cropped, unless the Auto Sync feature is enabled, refer to page 10-11.
Graph Menu

Compare Menu
This is a feature that enables you to compare run information when 2 runs are loaded.

Follow the steps below to compare run information:
1. Click on the Compare menu.
   **RESULT:** The Compare Data window appears.

   ![Compare Data Window](image)

   **NOTE:** The Compare Data window can be moved by selecting the window and dragging it to the desired area on the graph.

2. Click on an unselected channel in the run information to add that channel to the graph.
   **RESULT:** The channel is highlighted and displayed on the graph.

3. Click on a highlighted channel in the run information to remove that channel from the graph.
   **RESULT:** The channel is removed from the graph and no longer highlighted.

Correct Menu
Follow the steps below to correct noise spikes shown in the graph.
1. Click on the Correct menu.
2. Click on Start.

3. Position the pointer on the highest or lowest point of the noise spikes.
   **EXAMPLE:** See diagram below.

![Correct Menu Diagram](image)
4. After the pointer turns into a hand, click the **left mouse button**.

**RESULT:** The noise spike is removed from the graph. (This is not a permanent change.)

5. Click on the **Correct** menu.
6. Click **Stop**.

**Zoom Out Menu**

Follow the steps below to zoom in on a selected area of the graph:
1. Set the pointer to the area you want to zoom.
2. Press and hold the following keys:
   - Shift key.
   - Left mouse button.
3. Drag the mouse to the desired zoom window.
Graph Menu

Zoom Out Menu, cont’d

4. Release the shift key and mouse button.

RESULT: The selected area is displayed.

NOTE: You may zoom in as many times as you want.

Follow the steps below to zoom out, resetting the graph to its original size:

1. Click on one of the following:
   
   • Click on Zoom Out.
   • Press the ‘Z’ key.

RESULT: The graph returns to its original size.

Quick Menu

Follow the steps below to view different channel selections more quickly:

1. Click on the Quick menu.
2. Click on one of the different channel selections.

RESULT: The current graph disappears and your channel selection appears.
Log Menu

Follow the steps below to display the Log book for the current run:
1. Click on the Log menu.

RESULT: The Log book - (run number) dialog box appears.

2. Refer to pages 54-56 for complete features for the Log Book.

Window Menu
Displays the file name of the current run displayed.

Helpful Tips

Shortcut Keys
The following keys, on your keyboard, enable you to utilize specific features more quickly while viewing a graph:
- M - Maximize Graph. Refer to page 34 for more details.
- C - Customize Graph. Refer to pages 35-39.
- F - Customize Graph.
- Z - Zoom Out. Refer to pages 49 and 50.
- P - Print. Refer to page 45.
- Q - Displays right mouse button options. Refer to page 53.
- S - Shows data points. Refer to Mark Data Points on page 53.
- X - Displays the Export dialog box. Refer to pages 44-45.
- D - Displays the Export Dialog box.
- CTRL+A - Shows annotations, if the timeslip information is entered into the Log Book. Refer to page 42.

The following shortcut keys can be utilized from the Main Screen:
- CTRL+H - Displays the Log Book Entries dialog box for searching. Refer to pages 54-55.
- CTRL+L - Displays the Log Book. Refer to pages 55-56.
- CTRL+P - Displays the Previous Log Book Entry for adding logs. Refer to page 56.

The following shortcut keys can be utilized from both the Main Screen and while viewing a graph:
- F2 - Graph Selected Channels. Refer to pages 26-29.
- F3 - RPM Quick Graph 1. Refer to page 29.
- F4 - Cylinder Temp (EGT) Quick Graph 1. Refer to page 30.
- F5 - RPM Quick Graph 2. Refer to page 31.
- F6 - Cylinder Temp (EGT) Quick Graph 2. Refer to page 32.


**Helpful Tips**

**Helpful Tips, cont'd**

**Vertical Bar**

Follow the steps below to move the position of the vertical bar:

1. Select one of the following to move the vertical bar:
   - Left or right arrow keys - Moves the bar one hundredth of a second.
   - Page Up or Page down keys - Moves the bar one second.
   - Click anywhere on the graph and the bar will move to the point which you selected.

**Adding Channels on the Fly**

Follow the steps below to add or remove the channels displayed on the graph:

1. Click on an unselected channel in the run information to add that channel to the graph.

   **RESULT:** The channel is highlighted and displayed on the graph.

![](image1.png)

2. Click on a highlighted channel in the run information to remove that channel from the graph.

   **RESULT:** The channel is removed from the graph and no longer highlighted.

![](image2.png)
Right Mouse Button Options
When a graph is opened, clicking the right mouse button displays the following options:

**Viewing Style** - Selects the number of colors used when viewing a graph.
- Color
- Monochrome
- Monochrome + Symbol

**Font Size** - Selects the size of the font used when viewing a graph.

**Numeric Precision** - Determines how precise the measurements are on the graph.
- No decimals
- 1 Decimal
- 2 Decimals
- 3 Decimals

**Plotting Method** - Changes the appearance type of line displayed in the graph.
- Point
- Line
- Points + Best Fit Line
- Points + Best Fit Curve
- Points + Line
- Points + Spline
- Spline

**Data Shadows** - Not implemented in this version of software.

**Grid Lines** - Changes the appearance of the grid when viewing a graph.

**Grid In Front** - Moves the grid lines in front of the data on a graph.

**Mark Data Points** - This feature shows the exact points of data on the graph.

**Show Annotations** - Marks the annotations on the graph. See page 42 for further information.

**Undo Zoom** - Resets the graph to its original size after the zoom in feature is utilized. See pages 49-50 for further information.

**Maximize** - Hides the run information and expands the graph on the screen. See page 34 for further information.

**Customization Dialog** - Enables you to customize the graph. See pages 35-39 for further information.

**Export Dialog** - Enables you to export the graph in a different application. See pages 44 and 45 for further information.

**Help** - Not implemented in this version of software.
Log Book Menu

This is an excellent feature which enables you to do the following:
- Store and retrieve racing information.
- Import existing log information into the data base.
- Search the logs by categories such as corrected altitude, E.T.'s, MPH, track location, date and much more.

Search Log Info

Follow the steps below to search log information:
1. Click on the Log Book menu.
2. Click on Search Log Info.

RESULT: The Log Book Entries dialog box appears.

3. Click on the Eye icon to search through the log book entries.
RESULT: The Log Book Query window appears.
4. Input the criteria you would like to search by. For example, search all the runs with a corrected altitude between 1500' and 2000' by entering the information in the Corr Altitude Range field.

5. Click on OK to begin the search.

RESULT: The runs that met the search criteria appear.

6. Click on one of the following:
   - Double click on the listed run(s) to open the Log Book. See page 7 for further information.
   - Click on the Search icon to search again.
   - Click on the Refresh icon to view the complete Log Book entry pages.
   - Click on the Exit icon to return to the Main Screen.

Log Book

Follow the steps below to view the Log Book for the opened run:
1. Click on the Log Book menu.
2. Click on Log Book.

RESULT: The Log Book window appears.
NOTE: If two runs are opened, select Run 2 on the toolbar, to view the Log Book for that run.

3. If you are entering a new log, input the Run Name and all of the run information in the appropriate fields.
4. Click on one of the following icons:
   - Load - Enables you to open the run from the Log Book window.
   - OK - Saves a new log entry.
   - Import - Imports run information from a previous Log Book entry.
   - Delete - Deletes the Log book entry.
   - Exit - Returns you to the Main Screen without saving changes.

Add Previous Logs

Follow the steps below to add run information from your previous log books:
1. Click on the Log book menu.
2. Click on Add Previous Logs.

RESULT: The Previous Log Book Entry window appears.

3. Input the Run Name and all of the run information in the appropriate fields.
4. Click on one of the following icons:
   - Load - Enables you to open the run from the Log Book window.
   - OK - Saves a new log entry.
   - Import - Imports run information from a previous Log Book entry.
   - Delete - Deletes the Log book entry.
   - Exit - Returns you to the Main Screen without saving changes.
Window Menu

The options listed below are provided within the Window menu:

- **Cascade** - Used to arrange multiple log books.
- **Tile Horizontally** - Used to arrange multiple log books.
- **Tile Vertically** - Used to arrange multiple log books.
- **Arrange Icons** - Not implemented in this version of software.
- **Close All Windows** - Closes all of the open windows in the log book feature.

Help Menu

The options listed below are provided within the help menu:

- **About Data Facts** - Displays your name, address, city, state, zip and the software version number for 5 seconds.
- **Search For** - Not implemented in this version.
- **Contents** - Not implemented in this version.

Errors

If an error occurs, simply close and restart the program. If the problem persists, contact Auto Meter Products for further help.
Follow the steps below to make a Datalogger Helpful Tips card for your pocket. Use it as a quick reference to specific features while viewing a graph.

- Make a copy of this page. (Making a copy of this page will allow you to make multiple "Helpful Tips" cards if you loose or damage one)
- Cut along the dotted lines.
- Fold the page in half lengthwise so the Tips are on the outside.
- Tape the ends together.
- Fold the card in half lengthwise so it fits in your pocket.

**Icons**

Below is a list of icons provided on the main screen in order for you to execute a specific function more quickly.

- Open Data File 1 - Refer to page 16 for more detail.
- Open Data File 2 - Refer to pages 17.
- Download Data File - Refer to pages 14 and 15.
- Print Text Data File - Refer to page 18.
- Graph Selected Channels - Refer to pages 26-29.
- RPM Quick Graph - Refer to page 29.
- EGT Quick Graph - Refer to page 30.
- Log Book - Refer to pages 55 and 56.
- Search Log Books - Refer to pages 54 and 55.
- About Data Facts - Displays you name, address, city, state, zip and the software version number for 5 seconds.
- Switch Overlap Mode - Refer to page 11. (Overlap Axis)
- Switch Autoscale Mode - Refer to page 11. (Automatic Scaling)

**Helpful Tips**

The following keys, on your keyboard, enable you to utilize specific features more quickly while viewing a graph:

- M - Maximize Graph. Refer to page 34 for more details.
- C - Customize Graph. Refer to pages 35-39.
- F - Customize Graph.
- Z - Zoom Out. Refer to pages 49 and 50.
- P - Print. Refer to page 45.
- Q - Displays right mouse button options. Refer to page 53.
- S - Shows data points. Refer to Mark Data Points on page 53.
- X - Displays the Export dialog box. Refer to pages 44-45.
- D - Displays the Export Dialog box.
- CTRL+A - Shows annotations, if the timeslip information is entered into the Log Book. Refer to page 42.

The following shortcut keys can be utilized from the Main Screen:

- CTRL+I - Displays the Log Book Entries dialog box for searching. Refer to pages 54-56.
- CTRL+L - Displays the Log Book. Refer to pages 54-56.
- CTRL+P - Displays the Previous Log Book Entry for adding logs. Refer to page 56.

The following shortcut keys can be utilized from both the Main Screen and while viewing a graph:

- F2 - Graph Selected Channels. Refer to pages 26-29.
- F3 - RPM Quick Graph 1. Refer to page 29.
- F4 - Cylinder Temp (EGT) Quick Graph 1. Refer to page 30.
- F5 - RPM Quick Graph 2. Refer to page 31.
- F6 - Cylinder Temp (EGT) Quick Graph 2. Refer to page 32.
Keyboard Template

Follow the steps below to make a Datalogger Keyboard Template for your computer. Use it to quickly reference specific features while viewing a graph.

- Make a copy of this page. (Making a copy of this page will allow you to make multiple "Keyboard Template" cards if you lose or damage one.)
- Cut along the dotted lines.
- Fold the pages in half lengthwise so the Tips are on the outside.
- Tape ends together.
- Mount the Keyboard Template on your keyboard.

The following shortcut keys can be utilized from both the Main Screen and while viewing a graph:

- F1 - Cylinder Graph
- F2 - RPM Quick Graph
- F3 - Quick Graph
- F4 - Customized Graph
- F5 - Customized Graph
- F6 - Cylinder Temp (EGT)
- F7 - Cylinder Temp (EGT)
- F8 - Cylinder Temp (EGT)
- F9 - Cylinder Temp (EGT)
- F10 - Cylinder Temp (EGT)

Refer to page 53 for more details.

The following shortcut keys can be utilized from the Main Screen:

- CTRL+L - Displays the Log Book Entries dialog box for searching.
- CTRL+N - Displays the Log Book Entries dialog box for searching.
- CTRL+P - Displays the Previous Log Book Entry for adding tags. Refer to page 56.

Refer to page 56.